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This chapter describes how to get information about the contents of a graphics 

file, read image data from a file, and write image data to a file, using standard 

graphics and medical file formats. 
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Getting Information About a Graphics 
File 

To obtain information about a graphics file and its contents, use the imfinfo 

function. You can use imfinfo with any of the formats supported by MATLAB . 

Use the imformats function to determine which formats are supported. 
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Cont.. 

The information returned by imfinfo depends on the file format, but it always 

includes at least the following: 

Å Name of the file 

Å File format 

Å Version number of the file format 

Å File modification date 

Å File size in bytes 

 

 
 

7/15/2013 
Image Processing Techniques Using 

MATLAB 2012 
5 



Cont.. 

Å Image width in pixels 

Å Image height in pixels 

Å Number of bits per pixel 

Å Image type: truecolor (RGB), grayscale (intensity), or indexed 
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Reading Image Data 

To import an image from any supported graphics image file format, in any of 

the supported bit depths, use the imread function. This example reads a 

truecolor image into the MATLAB  workspace as the variable RGB.  

  RGB = imread('football .jpg') ; 
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Writing Image Data to a File 

To export image data from the MATLAB  workspace to a graphics file in one 

of the supported graphics file formats, use the imwrite function. When using 

imwrite, you specify the MATLAB  variable name and the name of the file. If  

you include an extension in the filename, imwrite attempts to infer the desired 

file format from it. For example, the file extension .jpg infers the Joint 

Photographic Experts Group (JPEG) format. You can also specify the format 

explicitly as an argument to imwrite. 
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Cont.. 

This example loads the indexed image X from a MAT-file, clown.mat, along 

with the associated colormap map, and then exports the image as a bitmap 

(BMP) file. 

 load clown 

 whos 
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Cont.. 

Your output appears as shown: 

 Name           Size              Bytes        Class      Attributes 

  X            200x320            512000    double               

  caption        2x1                   4      char                 

  map           81x3                1944   double  
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Cont.. 

Export the image as a bitmap file: 

  imwrite  (X, map, óclown.bmpô) 
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Converting Between Graphics File 
Formats 

To change the graphics format of an image, use imread to import the image 

into the MATLAB  workspace and then use the imwrite function to export the 

image, specifying the appropriate file format. 

To illustrate, this example uses the imread function to read an image in TIFF 

format into the workspace and write the image data as JPEG format. 
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Cont.. 

  moon_tiff = imread ( ómoon.tifô ); 

  imwrite  ( moon_tiff, ómoon.jpgô ); 
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The Image Processing Toolbox software includes two display functions, 

imshow and imtool. Both functions work within the Handle Graphics 

architecture: they create an image object and display it in an axes object 

contained in a figure object.  
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Displaying Images Using the imshow 
Function 

To display image data, use the imshow function. The following example reads 

an image into the MATLAB workspace and then displays the image in a 

MATLAB figure window. 
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Cont.. 

Example 

moon = imread ( ómoon.tif ô ); 

imshow (moon); 

Output 

7/15/2013 
Image Processing Techniques Using 

MATLAB 2012 
17 



Controlling the Appearance of the 
Figure 

By default, when imshow displays an image in a figure, it surrounds the image 

with a gray border. You can change this default and suppress the border using 

the 'border' parameter, as shown in the following example. 

  imshow ( 'moon.tif ', 'Border','tight  ')  
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Cont.. 

With Border Without Border 

7/15/2013 
Image Processing Techniques Using 

MATLAB 2012 
19 



Displaying Each Image in a Separate 
Figure 

The simplest way to display multiple images is to display them in separate 

figure windows. MATLAB  does not place any restrictions on the number of 

images you can display simultaneously. 

    imshow(I (:,:,:,1)) 

   figure, imshow(I(:,:,:,2))  

   figure, imshow(I(:,:,:,3))  
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Dividing a Figure Window into Multiple 
Display Regions 

 

subplot divides a figure into multiple display regions. The syntax of subplot is 

   subplot (m, n, p) 
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Cont.. 

Example 

I = imread ( óforest.tifô ); 

J = imread ( ótrees.tifô ); 

subplot (1, 2, 1), imshow (I)  

subplot (1, 2, 2), imshow (J) 

Output 
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Opening the Image Tool 

To start the Image Tool, use the imtool function. You can also start another 

Image Tool from within an existing Image Tool by using the New option from 

the File menu. 
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Cont.. 

Example 

moon = imread ( ómoon.tif ô ); 

imtool ( moon ) 

Output 
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Specifying the Colormap 

A colormap is a matrix that can have any number of rows, but must have three 

columns. Each row in the colormap is interpreted as a color, with the first 

element specifying the intensity of red, the second green, and the third blue.  

To specify the color map used to display an indexed image or a grayscale 

image in the Image Tool, select the Choose Colormap option on the Tools 

menu. This activates the Choose Colormap tool. Using this tool you can select 

one of the MATLAB  colormaps or select a colormap variable from the 

MATLAB  workspace. 
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Cont.. 
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Importing Image Data from the 
Workspace 

To import image data from the MATLAB  workspace into the Image Tool, use 

the Import from Workspace option on the Image Tool File menu. In the dialog 

box, shown below, you select the workspace variable that you want to import 

into the workspace. 

The following figure shows the Import from Workspace dialog box. You can 

use the Filter menu to limit  the images included in the list to certain image 

types, i.e., binary, indexed, intensity (grayscale), or truecolor. 
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Cont.. 
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Exporting Image Data to the 
Workspace 

To export the image displayed in the Image Tool to the MATLAB  workspace, 

you can use the Export to Workspace option on the Image Tool File menu. 

(Note that when exporting data, changes to the display range will  not be 

preserved.) In the dialog box, shown below, you specify the name you want to 

assign to the variable in the workspace. By default, the Image Tool prefills the 

variable name field with BW, for binary images, RGB, for truecolor images, 

and I for grayscale or indexed images. 
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Cont.. 
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Using the getimage Function to Export 
Image Data 

You can also use the getimage function to bring image data from the Image 

Tool into the MATLAB  workspace. 

  moon = getimage ( imgca ) 
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Saving the Image Data Displayed in the 
Image Tool 

To save the image data displayed in the Image Tool, select the Save as option 

from the Image Tool File menu. The Image Tool opens the Save Image dialog 

box, shown in the following figure. Use this dialog box to navigate your file 

system to determine where to save the image file and specify the name of the 

file. 
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Cont.. 

Choose the graphics file format you want to use from among many common 

image file formats listed in the Files of Type menu. If  you do not specify a file 

name extension, the Image Tool adds an extension to the file associated with 

the file format selected, such as .jpg for the JPEG format. 
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Cont.. 
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Printing the Image in the Image Tool 

To print the image displayed in the Image Tool, select the Print to Figure 

option from the File menu. The Image Tool opens another figure window and 

displays the image. Use the Print option on the File menu of this figure 

window to print the image. 
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Exploring Very Large Images 

If  you are viewing a very large image, it might not load in imtool, or it could 

load, but zooming and panning are slow. In either case, creating a reduced 

resolution data set (R-Set) can improve performance. Use imtool to navigate 

an R-Set image the same way you navigate a standard image. 
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Creating an R-Set File 

To create an R-Set file, use the function rsetwrite. For example, to create an R-

Set from a TIFF file called 'LargeImage.tif ', enter the following: 

  rsetfile = rsetwrite ( óLargeImage.tif ô ) 
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Opening an R-Set File 

Open an R-Set file from the command line: 

  imtool ( óLargeImage.rsetô ) 
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Navigating an Image Using the 
Overview Tool 

If  an image is large or viewed at a large magnification, the Image Tool displays 

only a portion of the entire image, including scroll bars to allow navigation 

around the image. To determine which part of the image is currently visible in 

the Image Tool, use the Overview tool. The Overview tool displays the entire 

image, scaled to fit . Superimposed over this view of the image is a rectangle, 

called the detail rectangle. The detail rectangle shows which part of the image 

is currently visible in the Image Tool. You can change the portion of the image 

visible in the Image Tool by moving the detail rectangle over the image in the 

Overview tool. 
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Cont.. 
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Panning the Image Displayed in the 
Image Tool 

To change the portion of the image displayed in the Image Tool, you can use 

the Pan tool to move the image displayed in the window. This is called panning 

the image. 
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Zooming In and Out on an Image in the 
Image Tool 

To enlarge an image to get a closer look or shrink an image to see the whole 

image in context, use the Zoom buttons on the toolbar. (You can also zoom in 

or out on an image by changing the magnification ð see Specifying the 

Magnification of the Image or by using the Ctrl+Plus or Ctrl+Minus keys. 

Note that these are the Plus(+) and Minus(-) keys on the numeric keypad of 

your keyboard.) 
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Specifying the Magnification of the 
Image 

To enlarge an image to get a closer look or to shrink an image to see the whole 

image in context, you can use the magnification edit box, shown in the 

following figure. (You can also use the Zoom buttons to enlarge or shrink an 

image. 
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Cont.. 
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Determining the Value of Individual 
Pixels 

The Image Tool displays information about the location and value of 

individual pixels in an image in the bottom left corner of the tool. (You can 

also obtain this information by opening a figure with imshow and then calling 

impixelinfo from the command line.) The pixel value and location information 

represent the pixel under the current location of the pointer. The Image Tool 

updates this information as you move the pointer over the image. 
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Example 

imtool ( ómoon.tifô ) 

Output 
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Determining the Values of a Group of 
Pixels 

To view the values of pixels in a specific region of an image displayed in the 

Image Tool, use the Pixel Region tool. The Pixel Region tool superimposes a 

rectangle, called the pixel region rectangle, over the image displayed in the 

Image Tool. This rectangle defines the group of pixels that are displayed, in 

extreme close-up view, in the Pixel Region tool window. The following figure 

shows the Image Tool with the Pixel Region tool. Note how the Pixel Region 

tool includes the value of each pixel in the display. 
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Cont.. 
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Determining the Display Range of an 
Image 

The Image Tool displays this information in the Display Range tool at the 

bottom right corner of the window. The Image Tool does not show the display 

range for indexed, truecolor, or binary images. (You can also obtain this 

information by opening a figure window with imshow and then calling 

imdisplayrange from the command line.) 
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Cont.. 

Example 

imtool (ómoon.tif ô ) 

Output 
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Measuring the Distance Between Two 
Pixels 

Example 

imtool ( ómoon.tifô )  

Output 
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Exporting Endpoint and Distance Data 

To save the endpoint locations and distance information, right-click the 

Distance tool and choose the Export to Workspace option from the context 

menu. The Distance tool opens the Export to Workspace dialog box. You can 

use this dialog box to specify the names of the variables used to store this 

information. 
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Cont.. 
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Cont.. 

After you click OK, the Distance tool creates the variables in the workspace, 

as in the following example. 

 whos 

 Name          Size            Bytes    Class     Attributes 

distance       1x1                 8      double               

point1          1x2                16     double               

point2          1x2                16     double  
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Customizing the Appearance of the 
Distance Tool 

Using the Distance tool context menu, you can customize many aspects of the 

Distance tool appearance and behavior. Position the pointer over the line and 

right-click to access these context menu options.  

Å Toggling the distance tool label on and off using the Show Distance Label 

option. 
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Cont.. 

Å Changing the color used to display the Distance tool line using the Set 

color option. 

Å Constraining movement of the tool to either horizontal or vertical using the 

Constrain drag option. 

Å Deleting the distance tool object using the Delete option. 

Å Right-click the Distance tool to access this context menu. 
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Getting Information About an Image 
Using the Image Information Tool 

To get information about the image displayed in the Image Tool, use the Image 

Information tool. The Image Information tool can provide two types of 

information about an image: 

Å Basic information ð Includes width, height, class, and image type. For 

grayscale and indexed images, this information also includes the minimum 

and maximum intensity values. 

Å Image metadata ð Displays all the metadata from the graphics file that 

contains the image. This is the same information returned by the imfinfo 

function or the dicominfo function. 
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Starting the Adjust Contrast Tool 

Example:  

imtool ( ómoon.tifô ) 
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Viewing Image Sequences as a 
Montage 

To view multiple frames in a multiframe array at one time, use the montage 

function. montage displays all the image frames, arranging them into a 

rectangular grid. The montage of images is a single image object. The image 

frames can be grayscale, indexed, or truecolor images. If  you specify indexed 

images, they all must use the same colormap. 
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Cont.. 

Example 

onion = imread('onion.png'); 

onionArray  = repmat(onion, [ 1 1 1 

4 ]); 

montage(onionArray ); 

Output 
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